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FCC Information to Users of this Equipment 
 
NOTE:   Changes or modifications not expressly 
approved by Pointred Technologies could void the 
user's authority to operate the equipment. 
 
NOTE: This equipment has been tested and found to 
comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against 
harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful 
interference to radio communications. However, 
there is no guarantee that interference will not occur 
in a particular installation. If this equipment does 
cause harmful interference to radio or television 
reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the 
following measures: 
 
-- Reorient or relocate the receiving antenna. 
-- Increase the separation between the equipment and 
receiver. 
-- Connect the equipment into an outlet on a circuit 
different from that to which the receiver is connected. 
-- Consult the dealer or an experienced radio/TV 
technician for help. 



 

 

FCC Information regarding Installation  
 
To meet regulatory restrictions, antennas must be professionally 
installed. 
 
 
Paragraph 1.1307 of FCC rules requires that to meet RF exposure 
limits, antennas must be installed so as to maintain at least 2m 
separation from all persons.   
 
This transmitter may not be co-located or operating in conjunction 
with other transmitters or antennas separated by less than 2m. 
 
 
This product may be used with a number of different  antennas in 
either point to point (p2p) or point to multipoint (p2mp) 
configurations.   FCC EIRP requirements limit power inputs to p2p 
and p2mp antennas.  The installer shall insure that the maximum 
power delivered to antennas is  in keeping with the table below: 
 
 
Description Antenna gain,  Maximum 

power, p2mp 
Maximum 
power, p2P 

    
Dish/grid 24 dbi 12 dBm 24 dBm 
Flat panel 15 dBi 21 dBm 26 dBm 
yagi 15 dBi 21 dBm 26 dBm 
omni   9 dBi 26 dBm 26 dBm 
    
 
 
 



 

 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Introduction 
Manual Pointred Technologies, 
Inc. 

 
 
Purpose 
This document describes the installation and 
configuration steps required for the Pointred 
Technologies, Inc. Microred Wireless Access 
system. 
 
 
 
 
 

 
 
 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
Product Description 
TECHNICAL DESCRIPTION 

 
1. System Description 

 

The MicroRed is a low to medium capacity 
Point to Multipoint Broadband Wireless Access 
operating in the frequency bands from 2.2Ghz to 
2.9Ghz. 

The MicroRed is offered in two main standard 
versions: 
 

• 4Mbit/sec Capacity 
• 8Mbit/sec Capacity 

 

Operation of the MicroRed is enhanced via 
the use of extensive software implementation and 
management functions. All configuration, 
operation and maintenance functions are 
performed either locally via the RS232 console or 
from remote via Pointred’s Network 
Management System (NMS). 

The MicroRed consists of a completely 
outdoor Base Station and of a desktop Customer 
Premises Equipment. On request Pointred offers 
Sector and Remote Antennas. 



 

 

 

 

 

 

 

The main advantages of the MicroRed 
system are: 

 

• Completely Outdoor Base Station, 
installable anywhere with no need 
for Head End or equipment room  

• On Board Routing 

• Superior Throughput 

• Point to Point and Point to 
Multipoint operation capability on 
the same platform. 

• Frequency Agility via software 
programmable Synthesizer 

• Modularity: any Modem Unit or 
Indoor Unit operates with any 
transceiver. 

• Non line of sight operation via 
routing through a Line of Sight 
CPE. Identification of all possible 
routing path to the NLOS CPE 
and storage in memory of the 

information. Periodic refresh of the 
database to avoid loss of the link 
with NLOS CPE. 

• Single interconnecting cable 
carrying the signals, the DC Power 
and the Telemetry Channels 

• Supports DHCP 

• 1+1 Hot Standby redundancy at 
the Base station 

 

 

 

 

 

2. Base Station 

 

The Base Station is the Wide Area Network 
Interface to the wireless system. A single 10BaseT 
port is provided to interface the network end at the 
Modem Unit. The Base Station consists of: 
 

• Base Station Unit 
• Transceiver 
• Sector Antenna 
 

Base Station Antenna with Microred Transceiver 

 



 

 

Base Station Unit 

 

 

 

 

The main features of the Modem Unit are: 

 

• Sending and receiving the data 
from/to the network through 
the Ethernet interface 

• Routing the data to the proper 
CPE based on the IP Address 

• Modulating/demodulating the 
data 

• Monitoring the LOS status of 
each CPE in the sector. 

• Allocating the specified 
bandwidth to each CPE based 
on the Quality of Service tool 
input 

• Supply the DC power to the 
Transceiver 

• Periodically polling each  CPE 
with control packets to verify the 
its bandwidth demand  

• Provide diagnostic information 
through the Network 
Management System 

• Configure the Transceiver 
through the Telemetry channel 

 
The Microwave Transceiver includes an 
up converter a down converter and a 
frequency agile programmable synthesizer. 

The main characteristics of the transceiver 
are: 
 

• Frequency Agility 
• Extremely compact and 

lightweight 
• Ease of installation 

 
The Sector Antenna defines the size and 
the depth of the sector on the basis of the 
beam width and antenna gain. Pointred 
offers three different versions with 60, 90, 
120 degree beam width.  
 
 
 
 
 
 
 
 
 
 

 
 

3. Customer Premises Equipment 
(CPE) 
 

A CPE consists of a desktop Indoor Unit of 
an outdoor Microwave Transceiver identical to 
the one used for the Base Station and of a small 
antenna.  

CPE Modem Module 

 

Corner reflector 

 



 

 

Spot Beam 

 

Flat Panel 

 

The CPE Indoor Unit major features are: 

 
• Ease of installation 
• Small Size and Weight 
• Capable of supporting other 

LAN devices like Voice over IP 
phone, either SIP or H323 
protocol, and 802.11b Access 
Point. 

• 110/220VAC operation 
• Low Cost 

 
In its simplest operation, the CPE can be connected to 

the Ethernet port of a computer to provide broadband 
access to the end user. 

Pointred offering for the Remote Antennas are: 

 

• Corner Reflector 

• Spot Beam 

• Flat Panel 

All antennas need a remote mount and antenna jumper 
cable to connect to the transceiver. 

 

 

 

 

 

 

 

 

 

 

 

 

Technical Specifications 

 
Base Station Includes:  
 

• 1 Modem/Network Interface Unit (Ethernet 
Interface)  

• 1 Microwave Transceiver  
• 1 Transceiver Installation Kit (includes mounting 

brackets)  
• Base Station mounting bracket includes bracket 

that mounts to the pole/mast, size of bracket 1.25” 
for small pole/mast  

• 1 Installation and Configuration Manual  
 
Base Station Backhaul Interface Options: 
 

• 1T1 Interface  
• 1E1 Interface  
• 2T1 Interface  
• 2E1 Interface  
• Uninterrupted Conditioned Power Backup for Base 

Station.  
 
Base Station 4Mbit/sec Specification: 
 

• Frequency: 2400-2486Mhz  
• Frequency Agile to any 1 MHz channel via 

software controls  
• Power Agile from 1 milliwatt to 250 milliwatt  
• Frequency Step: 1 MHz  



 

 

• Capacity: 4Mb/s  
• Max Throughput: 5Mb/s  
• Channels Allocation: 1 MHz  
• BTS Network Interface: 10BaseT, E1 (optional), 

2xE1 (optional)  
• Power Supply: 110/220 VAC for Base Station  
• Power Consumption: 17 Watt  
• Dimensions: 525x212x125 mm for the Base Station  

165x165x40 mm for the Transceiver  
• Antenna Interface: N Connector 50ohm Female  
• Alarming: Transceiver not responding, WAN 

Packets Loss  
• Output Power: +22dBm guaranteed  
• Receiver Sensitivity: -75dBm  
C 95% humidity°C +65°Environmental: -30 

CPE Unit Includes: 
 

• 1 CPE Modem unit.  
• 1 Microwave Transceiver.  
• 1 Installation and Configuration Manual.  

 
CPE Antenna Option: 
 

• Omni Antenna 6dBi  
• Omni Antenna 8dBi  
• Spot Beam 15dBi  
• Panel Antenna 14 & 15dBi  
• Reflector Antenna 24dBi  
• Corner Reflector 12dBi  

 
CPE 4Mbit/Sec Specification: 
 

• Frequency: 2400-2486 MHz  
• Frequency Step: 1.0  MHz  
• Capacity: 4Mb/s  
• Max Throughput: 5Mb/s  
• Channels Allocation: 1 MHz  
• CPE Network Interface: 10BaseT  
• Power Supply: 110/220 VAC  
• Power Consumption: 17 Watt  
• Ventilation: Not Applicable  
• Dimensions: 200x138x57mm for the CPE, 

165x165x40 mm for the Transceiver.  
• Antenna Interface: N Connector 50ohm Female  
• Alarming: Transceiver not responding, WAN 

Packets Loss  
• Output Power: +22dBm guaranteed  
• Receiver Sensitivity: -75dBm  
• Environmental:  -10°C  to + 50°C for the CPE 

Modem Unit.  -30°C to      +65° 95% humidity for 
the Transceiver.  

                                               
Point to Point Specification 4Mbit/sec 

 
• Frequency: 2400-2486 MHz Band  
• Frequency Step: 1 MHz  
• Capacity: 4Mb/s  
• Max Throughput: 5Mb/s  
• Channels Allocation: 1 MHz  
• BTS Network Interface: 10BaseT, E1, 2E1  
• Power Supply: 110/220 VAC  
• Power Consumption: 17 Watt  
• Ventilation: Not Applicable  
• Dimensions: 525x212x125 mm for the Modem Unit; 

165x165x40 mm for the Transceiver  
• Antenna Interface: N Connector 50ohm Female  
• Alarming: Transceiver not responding & WAN 

Packets Loss  
• Output Power: +22dBm guaranteed  
• Receiver Sensitivity: -75dBm  
C 95% humidity°C +65°Environmental: -30
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1.0 BTS Site Qualification 
1.1 Terrain Factors 

Choose Base Station locations based upon the following Factors: 

a. Broadcast Coverage 

b. Obstructions in the Broadcast Area 

c. Subscriber Potential 

d. Costs to Operate 

1.2 Licensing: Federal, State, County, and Sales Taxes 

Operators must comply with all Local Spectrum and Facilities Licensing Regulations, Fees, 
and Taxes prior to Broadcasting.  
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2.0 Base Station Installation 
1.1 Interference Testing Steps 

Wireless Data operators are faced with hundreds of antenna installations. Each 
subscriber presents a unique set of circumstances that must be considered when 
setting up a subscriber system. The variables which govern decision-making include 
- (1) the distance and direction to broadcast antenna, (2) any signal blockage at the 
residence, (3) the type of structure, and (4) the orientation of the structure with 
respect to the broadcast antenna. Distant blockage, which cannot be seen at the 
residence, can sometimes influence line-of-sight reception. Thus, the location of the 
antenna can sometimes be critical to reception. It can mean the difference between 
connecting a new subscriber and losing one. As a result, a wide variety of antenna 
mounting systems has evolved building upon systems created for mounting other 
types of antennas. 
 

Prepare a Site survey Kit that includes the following basic items: 

1. Lightweight Survey Antenna w/Mount kit 

2. Telescopic Survey Mast or “Hotstick” 

3. Microred Transceiver Unit 

4. Signal Level Meter w/power supply onboard 

5. 2 25 meter RG-6 Coaxial Cable w/connectors 

6. Test CPE with RF Splitter (5-500Mhz) 

7. 1 10meter RG-6 Coaxial Cable w/connectors 

8. Expandable Ladder 

9. Basic Hand Tools 

10. Documentation 

11. Notebook PC and Null Modem Serial Cable 

12. 50Ohm Coax cable 3 meters w/ connectors 
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Optional Accessories: 

2. GPS 

3. Compass 

4. Binoculars 

5. Location Map 

6. First Aid Kit 

7. Spectrum analyzer 

8. Coaxial Adapters 

Survey Steps: 

NOTE: The Site survey performs as a test of the LOS at various locations within the Base 
Station installation location. Considerations for Reception and Transmission quality are LOS 
(line of Site), Interference, and Multi-path, cable routing, and permissions. The Survey 
Technican must evaluate several Possible Antenna Mounting locations for the Base Antenna 
and determine the best location that accomidates the above considerations.  

1. Connect a CPE Pannel antenna to a 50Ohm Coax cable. 

2. Connect the Other end of the 50Ohm cable to the Spectrum Analyzer 

3. Tune the Analyser to view the desired portion of the spectrum 

4. Holding the antenna in you hand in vertical polarity begin to pass the 
antenna from left to right a full 360 across the desired broadcast area. Note 
the signals detected and record them in the documentations. Repeat the 
process in Horizontal polarity. Ideally you will not detect any other signals 
within your desired band. If there are “undertermined or unwanted signals” 
in the area in which you intend to broadcast, consult you system RF 
engineering team. 

5. Document all information like height, GPS, and Rooftop location in the site 
survey form.  

6. Repeat steps 1-5 at various other possible mounting locations on the roof.  

7. Finally, determine which of the surveyed locations is the best for the 
following considerations: 

a. Cable Routing, LOS coverage, Interference rejection, Mounting potential 
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1.2 Back Haul Access 

Determine where in the Backhaul connection is located and note this in the Survey form. 
The backhaul availability and configuration will be determined by the system Network 
administrator. The Survey technician must realize the distance and route to the Backhaul 
from the Base Station/Router location.  

1.3 Site Access 

In choosing a Base Station location, determine if the location is suitable for operational 
personnel. The site MUS have 24/7 physical access for support and recovery operations. 

1.4 Power Quality  

The Base station power source must compliant to the local Electrical code. Consult the 
location owner for qualification information. In some cases a Un-interrupted power supply 
may be used to both provide power failure recovery and power conditioning. Consult you 
Network administrator for Configuration and installation instructions 

1.5 Zoning 

Zoning and license permissions for the site to be used for Radio broadcasting must be 
complied with. Consult your Network administrator for verification of the approval and or 
process. 

1.6 Aeronautical Concerns 

The proposed Base Station site must comply with all Local Aeronautical regulations such as 
Antenna height and location, Beacon marking requirements, and notices 
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1.8 Hard Ware installation Steps 

Pre-Installation Requirements: 

1. Surveyed BST Mounting location with suitable grounding connection.  

2. 110/220VDC source 

3. Internet or Other media Connection interface (IP Router)  

4. Suitable Broadcast Antenna 

5. Basic Hand Tools 

Component Inspection:  

1. Carefully unpack the Base Station package and inspect the unit for physical damage. 

2. Verify that all the components are present against the shipping information or 
Purchase order.  

Immediately contact PointRed Technologies if any portion of the system base 
station package is missing or damaged. 

 

Mounting the BASE STATION: 

1. Vertically mount the BST using the supplied mounting hardware with the F-Type 
75ohm connection downward.  
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Connecting the BASE STATION: 

1. Connect the Ground point to the BASE STATION mount. 

2. Connect a F-Type 75ohm Coaxial cable to the F-Type 75ohm connection point of 
the BST. Note: DO NOT OVERTIGHTEN the F-Type 75ohm connector and 
DO NOT connect any cable to the BST while the unit is powered! POWER 
OFF FIRST! 

3. Connect the other end of the F-Type 75ohm Coax cable to the PointRed 
Transceivers F-Type 75ohm connection point. As pictured below. Then, connect an 
N-Type 50ohm Coax Cable to the Transceivers N-Type 50ohm connection point.  

 

 

 

4. Connect the other end N-Type 50ohm coax cable to BAST Station Antenna’s           
N-Type 50ohm Connection Port as pictured below. 
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5. Connect an Ethernet CROSSED cable with a standard RJ-45 connector to the 
Backhaul connection point of the BASE STATION. The other end of the Ethernet 
Crossed cable to your Media Connection such as a Router.  

Here is an image of the final installation configuration below 

.  
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1.10 Connecting to the Base Station 

Connecting to the System Using Hyper term 

Pre-Configuration Requirements: 

1. Installed BASE Station and CPE Modem 

2. PC with Win 2000, 128megRam, Pentium II, with Serial Port  

3. 9-pin RS-232 Serial Cable with Null Modem 9pin 

4. Ethernet 10baseT CROSSED Cable 

1. Test Server PC 

Connecting to the Base Station and CPE console port  

1. Connect the RS-232 cable to the CPE Modem RS-232 Port or the Base Station RS-
232 port. (See Configuring the Base Station) 

2. Connect the other end of the RS-232 Serial cable to the Null Modem.  

3. Connect the Null Modem to the RS-232 port of the PC.  
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4. Left Click, Start>Programs>Accessories>Communications>Hyper terminal 

5. Click to Open Hyper terminal. 

6. At the Hyper Terminal Window you will see a dialog box (Connection description). 
Enter the following:  “System Configuration” 

 

 

 

 

 

 

 

Here is an image of the Dialog Box “Connection Description” 

 

 

7. Click OK. You should see a dialog box named “Connect To”. Select the proper 
COM port connected to the RS-232 Serial cable. 

Here is an image of the Dialog Box “Connect to” 
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8. Click OK. You should see a dialog Box named “Com (your com port)” 

Select the following: 115,200 bits per second, 8 data bits, None Parity, and None for 
Flow control. Also assign your PC’s Com Port. If you are unsure of you COM port, 
click Start>Control Panel>Ports to find your Com Port configuration 

Here is an image of the Dialog Box   with “ COM2 Properties” 
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9. Click OK. You should now return to the hyper terminal window. Type “Enter” 
You should see the Point Red Configuration Prompt. 

Cont. 

 

 

 

 

 

 

Here is an image of the Hyper Terminal Window: Type “Enter” to see the PR> 
prompt. 
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 You are now ready to configure the Network Settings for the PointRed System.  

 

1.11 Configuring the Base Station Steps 

This Chapter describes all the commands available for the user/administrator to see 
and modify the system settings.  
This document also provides the commands syntax and system response for each 
command. 
 
The system commands are: 
 

1. "help" 
The "help" command introduce all available commands. 
    

a. On the BASE-STATION system: 
 
   Command:    
      help<ENTER> 
   Response: 
      help      - Show this help menu          
      enable    - UART: login Administrator    
      disable   - UART: logout Administrator   
      state     - Show current station setup   
      lanip     - Show/Set LAN IP Address      
      landg     - Show/Set LAN Default Gateway IP Address 
      wanip     - Show/Set WAN IP Address     
      wgateip   - Show/Set WAN Default Gateway IP Address 
      addcpe    - Add CPE to the system        
      delcpe    - Remove CPE from the system   
      listcpe   - List CPEs in the system      
      commit    - Save configuration to the FLASH 
      reset     - Reset System 
      trfrq     - Set transmit frequency 
      trmode    - Set frequency band 
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      trpwr     - Set the output power level 
                       
 
 
 

On the CPE-MODEM system: 
 
   Command:    
      help<ENTER> 
   Response: 
      help      - Show this help menu         
      enable    - UART: login Administrator   
      disable   - UART: logout Administrator  
      lanip     - Show/Set LAN IP Address     
      landg     - Show/Set LAN Default Gateway IP Address 
      commit    - Save configuration to the FLASH 
      reset     - Reset System                
 
 
 
 

2. "enable" 
The "enable" command allows the user to login as the administrator for modifying the 
system settings. 
 
   Command:    
      enable<ENTER> 
   Response: 
      Password: 
   Command:    
      <password><ENTER> 
   Response: 
      --  Welcome to UART Admin 
 
                   

3. "disable" 
The "disable" command causes the system to exit from administrator. 
 
   Command:    
      disable<ENTER> 
   Response: 
      <prompt> 
 
 
        
 
 
 
     

4. "state" 
The "state" command allows the user to see the current system configuration. 
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   Command:    
     state<ENTER> 
   Response: 
     Base Station 
     LAN IPAddress:192.168.0.2 IPMask:255.255.255.0 
Gateway:192.168.0.1 
     WAN IPAddress:  192.0.0.1 IPMask:255.255.255.224 
 
 
 

5. "lanip", "landg", "wanip" and "wgateip" 
The "lanip", "landg", "wanip" and "wgateip" commands allow the user to see the 
current system IP settings and to the administrator to modify these settings. 
 

a. To see the current system LAN IP address: 
 
   Command:     
      lanip<ENTER> 
   Response: 
      Current Lan IP: 10.0.0.2 
         usage: lanip X.X.X.X [ netmask ] 
 

b. To modify the current system WAN IP address: 
 
   Command:    
      wanip 192.0.0.7 255.255.255.0<ENTER> 
   Response: 
      replacing net if2 IP address 192.0.0.1 with 192.0.0.7 
 
 

6. "addcpe" and "delcpe" 
The "addcpe" and "delcpe" commands allow the administrator to add new CPE to the 
system or to remove unused CPE from the system. 
 
   Add command syntax:     addcpe <mac address> <LAN address><ENTER> 
   Delete command syntax: delcpe <LAN address><ENTER> 
 

a. For example: 
 
   Command:    
      addcpe 00.11.22.33.44.55 10.0.8.1<ENTER> 
   Response: 
      ....   CPE added to the list successfully ... 
 
 

b. Another example: 
 
   Command:    
      delcpe 10.0.8.1<ENTER> 
   Response: 
      Entry successfully deleted .... 
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7. "listcpe" 
The "listcpe" command shows to the user all the CPE's that configured in the system.  
 

For example: 
 
   Command:    
      listcpe<ENTER> 
   Response: 
      CPE list: 
           Number of CPE(s) : 2 
 
      [CPE 1] 
         Mac address 0.11.22.33.44.c2 
         LanIP   10.0.1.1        WanIP   192.0.0.3 
 
         Number of packets sent  : 0 
         Number of bytes sent    : 0 
 
 
      [CPE 2] 
         Mac address 0.11.22.33.44.c8 
         LanIP   10.0.0.1        WanIP   192.0.0.2 
 
         Number of packets sent  : 38440 
         Number of bytes sent    : 53989430 
 
 

8. "commit" 
The "commit" command lets the administrator to save the new settings in the flash so 
if the system restarts due to user demand or power failure, no new settings will be lost. 
 
   Command:    
      commit<ENTER> 
   Response: 
      copy -f –f 0x7F0000 0xBFDF0000 0x4000 
      100%, 0x4000/0x4000 bytes loaded 
 
 

9. "reset" 
The "reset" command lets the administrator to reset the system. Reset command must 
be applied for the new IP settings to take place. 
 
   Command:    
      reset<ENTER> 
   Response: 
      <system restart> 
 

10. "trfrq" 
The "trfrq" command lets the administrator to set the transceiver frequency. Valid 
values range from 2405 to 2480 in increments of 5 MHz. 
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   Command:    
      trfrq 2450<ENTER> 
   Response: 
      Transceiver Frequency Changed: Old=2475, New=2450 

11. "trmode" 
The "trmode" command lets the administrator set the CPE to the transceiver frequency 
band. 2.4Ghz =trmode 0 
  
   Command:    
      Trmode 0 <ENTER> 
   Response: 
      2.4 Ghz system frequency band 
 
 

12. "trpwr" 
The "trpwr" command lets the administrator to set the transceiver power. Valid values 
range from 0 to 255. 
 
   Command:    
      trpwr 128<ENTER> 
   Response: 
      Transceiver Power Changed: Old=119, New=128 
 

RF Configuration Procedure for the Base Station 

 This procedure details the steps needed to set the base station’s RF operational parameters.  

1. Open the Base Station cover and connect to the RS-232 port and your PC. Open 
Hyperterminal and type enter. You should see the PR> prompt.  

2. To Set the Frequency for 2.4 Ghz range type “enable” then enter the password. 
Type “admin”. You should see the admin> prompt. Type “trmode 0” for 2.4 Ghz 
range. 

3. Next, determine the center frequency for radio channel you which to use. Type 
“trfrq xxxx” and type enter.  Example: trfrq 2475. Type  “commit” enter and Y” 
enter to save the setting. Next, type tfrq to verify system settings. Example : trfrq  
OLD=2450 NEW=2475. 

4. To set the System power level. Type “trpwr 255” enter. Type “commit” and “Y” to 
save the setting. You may type “trpwr” again to verify. This will set the system 
power level to maximum output. It is recommended to use maximum power level 
for most configurations. 
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5. The PoinRed CPE modem is configured exactly as detailed the previous steps.  All 
CPE modem that subscribe to the Base Station in a given MicroCell must have the 
same Radio Frequency configuration as the Base Station 

This Completes the RF configuration 

Network Configuration Procedure for the Base Station 

This procedure details the steps needed to set the base station’s IP Network operational 
parameters. Contact Pointred Technical support fro assistance in determining your network 
IP scheme. 

1. Open the Base Station cover and connect to the RS-232 port and your PC. Open 
Hyperterminal and type enter. You should see the PR> prompt. 

2. Type, “enable” and enter the Password “admin’”. You should see the admin 
prompt. Type “lanip xxx.xxx.xxx.xxx” then enter and commit to set the IP of the 
Base Station. 

3. Next type “landg xxx.xxx.xxx.xxx” to set the Default Gateway for the Base Station 
then, enter and commit to save the setting.  

4. Type “wanip xxx.xxx.xxx.xxx enter and then commit and y to save the setting.  

5. Next, type “wgateip xxx.xxx.xxx.xxx” to set the WAN default gateway. Type 
commit and y to save the setting.  

6. Type, “state” to verify all the above settings. The PoinRed CPE modem is 
configured exactly as detailed the previous steps.  All CPE modem that subscribe to 
the Base Station in a given MicroCell must have the same Radio Frequency 
configuration as the Base Station.  

7. Type disable to exit the Administrator login 

This Completes the RF and Network configuration.  
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Add/Delete CPE at the Base Station 

This procedure details the steps needed to add CPE’s to the base station’s database. Contact 
Pointred Technical support for assistance or questions. 

1. At the Base Station via RS-232 connection type enable and the password admin to 
enter the administrator functions. 

2. Type “ listcpe” to show all of the current added cpe. Next type “addcpe” and enter 
the IP address and MAC address of the CPE you wish to add to the system.  

3. To delete a  CPE entry type “delcpe”.  

4. To save the CPE’s you have added to the system type “commit” and “Y” then 
enter.  

This completes the step to add or remove a CPE at the Base Station.  

 

 

Contact PointRed Technical support for assistance.  

Call: 1-408-383-0153 for Customer Support 

 www.pointredtech.com   

 

 

 

 

 

 

 

 

1.12 Configuring the Linksys Router Steps 

Backgrounder: 



 

 1919 

 
The Linksys BESFR41 router is used to set a Static IP route for connectivity between the Microred CPE Modem Module 
and the Microred Base Station. The Router also provides Backhaul Internet connectivity to devices connected to CPE modems on 
the Microred network. Below are the steps required to configure the router for use with a standard Microred IP configuration. 
The BESFR41 router has a default configuration that must be re-configured in order to comply with the Mi crored system standard 
IP configuration. The default IP address of the BEFSR41 is 192.168.1.1. The default password is “admin” with NO user name 
entered in the Loggin field.  
 
Requirements: 
The following items are needed to configure the BEFSR41: 

1. Linksys BEFSR41 Cable/DSL router with supplied power supply  
2. Straight Ethernet cable/RJ-45 connectorized 
3. Win 95 or higher PC with NiC 10/100BT. 
4. Compliant 110vdc power source 

Configuration Steps: 
1. Connect the BEFSR41 to the supplies power supply and plug the power su pply into the compliant 110vdc source. 
2. Connect one end of the Ethernet Straight cable to the PC’s Nic RJ-45 interface. 
3. Connect the other end of the Ethernet straight cable to Port 4 of the BEFSR41 router. 
4. Set the IP address of the PC NiC to the following settings and Reboot the PC. 

 
IP                        192.168.1.5 
Subnet                 255.255.255.0 
Default Gateway 192.168.1.1 
DNS                    0.0.0.0 

 
5. Optional step. Verify the PC’s IP address setting by opening the windows Command Prompt window and typing 

Ipconfig or winipconfig.  
6. Next open the IE explore application and enter the Routers default IP address into the address bar of IE explorer. Click 

“GO”. 
7. You should see the following window: 
 
   

                            
 
8. Enter the router default password in the Password box. “admin”. Click okay. 
9. You should see the following window appear. If not, verify the IP address of the PC you are using. 
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10. Next, Change the (Device IP address) to 192.168.0.1 and click okay, then continue. 
11. You should lose connectivity to the Router as you have just set the IP address to a different network than the network 

address set on your PC. Set the PC to 192.168.1.5 and the Default Gateway to 192.168.1.1 to match the Routers new IP 
settings. Reboot the PC and re-open IE explorer. 

12. Type 192.168.0.1 in the address box and click GO. You should see the following box appear. Enter the “admin” 
password as before and click OK. You should see the following window appear showing the new IP address of the 
route as pictured below. 

 
 

                  
 
13. Next, Click the Advanced tab on the top right of the window. Then click the Static Routing tab. You should see the 

following window appear. This is the configuration dialog for routing the CPE 10.0.X.X IP address’ to the BTS. We will 
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set a route of 10.0.0.0 to 192.168.0.2 as pictured on the next page below. Enter the address of 10.0.0.1 in to the 
Destination LAN IP dialog of the router. Enter 255.255.255.0 into the Subnet dialog. Enter 192.168.0.2 into the 
Default gateway dialog and click “apply” then continue. You should see the following window on the next page. HOP 
count of “5” and LAN should be set also. Set them in this window also. 

 

         
 
14. Click the Dynamic Routing Tab. You should see to Radio buttons. Click on the “Router” button. This will enable the 

Router to perform the Static route you set in step 13. You should see the window below when you first select the 
Dynamic router tab.  
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15. Next Click the Setup Tab again and Click on the Wan Connection Type Drop down box. Select “Static IP”. This is 
where you will enter the Backhaul connection IP information. Enter the IP, Subnet Mask, Default Gateway and DNS 
server address’. Consult your Network administrator for these settings. The next section describes the Backhaul 
interface requirements. Once you have entered these setting Click “Apply” and “Continue “. This completes the 
BEFSR41 Configuration. 

 

 
 
1.12 Backhaul Interface 

The Base Station Router requires an IP address that is either Public or Private to connect to 
the internet and other servers. Consult you System network Administrator for these settings: 

IP address: xxx.xxx.xxx.xxx 

Subnet: xxx.xxx.xxx.xxx. 

Gateway: xxx.xxx.xxx.xxx 

DNS: xxx.xxx.xxx.xxx  

You will need to enter these as the WAN settings of the Router.    
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1.14 Power Configuration Steps 

Consult you local Network Administrator for the proper configuration and Installation steps 
for both Power connection and UPS configurations. 

1.15 Cable Routing 

Down-Lead Routing: The coaxial down lead should be routed to the entry point 
by the most direct route possible. However, the route should always be either 
vertical or horizontal. Down-leads should never be routed across a wall at an angle. 
Sharp bends or kinks in a coaxial cable should be avoided since they can influence 
the cable’s frequency response. The effect of a sharp bend or kink can be so serious 
that the response may create a deep “notch” in the frequency response at some 
particular frequency. Damaged or broken coax can result in signal leakage. If 
external signals leak into the system, it can degrade reception. Also, if signals leak 
out of the system it could interfere with other radio services. Leakage is never one 
way. If signals are leaking into the down-lead system, they will also be leaking out. 

It is good practice to make a “drip loop” at the point where the coaxial cable 
enters the building. This loop prevents water from entering the building by dripping 
down the coaxial cable. It is also good practice to make service loops with the coax 
near the connectors at both the top and bottom of down lead. Service loops are also 
made on both connections to the ground block or at any point where an F connector 
is used. These loops provide extra cable for connecting test equipment during 
troubleshooting. They also provide some extra cable length in the event that bad 
connectors have to be replaced sometime in the future. Service loops are made 
twisting several turns of coax into a 4-inch loop and securing them with tie-wraps. 
Service loops perform three functions. First, the additional cable length makes it 
easier to connect test equipment. Second, the additional length makes it easier to 
replace F-connectors. Third, in some instances service loops may double as drip 
loops. 
 

The RG-6 IF Cable routing consideration are: 

a. Distance from the Transceiver port to the Location (Maximum is 66 meters 
or 200 feet.) 

b. Follow the shortest possible route to the BTS 

c. Attach the cable to the building structure with a cable clip at least every 
meter in straight direct lines. Use Cable Ties to provide for replacement of 
connectors. 
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1.16 Grounding 

Grounding: Most experts agree that the most important purpose over-riding of grounding 
is safety. There are two aspects of grounding an antenna system. The first involves 
grounding the coaxial down lead. The second involves grounding the antenna mounting 
system. Proper grounding is a concern for several reasons. Improper grounding could 
present a shock or fire hazard. It could also create regulatory problems with respect to local 
codes and ordinances. It is incumbent upon each wireless operator to assure that installation 
practices in any particular locality comply with all federal, state, and local fire codes and 
electrical codes. Failure to scrupulously follow such standards could create a serious liability 
for the data operator if a subscriber’s home burns down as a result of lightning strike. 

a. Connect a Grounding block in line between the Transceiver and the BTS. 

b. Connect a #10 copper ground wire to the Ground block Ground terminal 

c. Route the Copper Ground wire to the Closest approved ground point. 
Consult you local Network administrator for local regulations pertaining to 
grounding.  

 
Grounding Masts & Supports: Article 810 of the NEC stipulates that masts 

and supporting mounts be grounded to provide discharge path to ground. When a 
near lightning strike occurs, powerful electromagnetic fields can induce surges in 
nearby conductors. Static charges can also build up during high winds. Hence, masts 
and supporting structures should be grounded using # 10 gauge wire. Connecting a 
second ground lead between the masts, mounting tripod, does this and coaxial 
ground block at the entry point. The ground lead may be attached to a mast using a 
ground strap. However, some installers use another ground block on the mast. The 
ground wire is then run from the antenna mount to the mast block and then down to 
the ground block at the near the point of entry. Article 810-17 (b) requires that any 
splices in a ground line must be permanent crimped splices made with a crimping 
tool. If the ground block at the point of entry is connected to a power riser, the mast 
and supporting mount may also be grounded to the same riser pipe (at the top). 

 
Ground Wire Routing : Like the coaxial down lead, the ground lead should routed to 
ground outside the building by the straightest and most direct route possible. 
However, this route should always be either vertical or horizontal. Usually this is 
done by simply following the coaxial cable. Sharp bends in the ground wire should be 
avoided. It is important for the installer to assure a physically secure ground with a 
good electrical bond. A physically insecure connection could work loose. An 
electrically unsound bond will result in a high resistance ground. Ground wires should 
also be marked with warning labels, which read: 

- CAUTION - 
Ground Wire  

Do Not Remove 
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Although Articles 810 and 820 allow inside routing of ground wires, ground wires 
should always be routed outside the building. In the event of a lightning strike, the 
outside routing will canny the lightning surge directly to ground on the outside of 
the building rather than carrying the surge inside the building. 
 
Driving Ground Rods: It is generally a good idea to avoid driving ground rods if 
the power service ground can be used. Although driving a ground rod costs more 
than using a preexisting ground, the reason for preferring the power company’s 
ground is technical rather than financial. When a building has two earth grounds, the 
possibility of a difference of potential between the two around points exists. This 
presents a potential shock hazard. It also creates the possibility of arcing during an 
electrical storm. However, there are occasionally situations in which it may be 
necessary to drive a ground rod 

When it is not feasible to reach the power service ground, a ground may be 
established using an 8-foot rod. Articles 250-8 1 and 250-83(cX3) recommend either 
a stainless steel rod with a diameter of 1/2-inch or an iron or steel rod with a 
diameter of 5/8th inch. Whenever an additional ground is used, both Articles 810 
and 820 require that the second ground rod be interconnected to the power service 
ground using # 6 gauge wire. This cable functions to equalize any difference 
between the two grounds and may be routed inside the building. Allowing the mast 
to extend above the Antenna will help protect the Transceiver from lightning 
strokes. However, since lighting can strike horizontally, this procedure may not 
always protect the Transceiver. Nevertheless, it will make the Transceiver a less 
likely target.  
    

Grounding Towers: Because tall towers make good targets for lightning, it is 
essential to ground both the tower structure and the down lead correctly.  Masts 
should be grounded directly to the tower structure. The tower structure should be 
grounded to an eight- foot ground rod 
Driven completely into the earth at the bottom of the tower. If shale or rock makes 
use of an eight- foot ground rod impossible, then two four foot ground rods should be 
driven eight feet apart and connected in parallel. The down lead should be grounded 
to the tower structure using a ground block at the top of the tower, at the bottom of 
the tower and at intervals of 150-feet along the tower structure. Since most towers 
used for wireless reception systems are one hundred feet or less in height, most 
reception systems only need a ground block at the top and the bottom of the tower. 
The down lead should be grounded again to the power service ground using an 
additional ground block where the cable enters the building. The purpose of this 
strategy is to short lightning strikes, which hit the tower structure, 
directly to ground. Because the pound resistance is lower, the ground blocks mounted on 
the tower structure will short lightning surges or static charges directly to ground through 
the tower structure rather than the down-lead shield. Any remaining charge on the down-
lead shield will be shorted to the power service ground. 
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1.17 Weather Protection 

Weatherproofing: External F Type connectors are weatherproofed against corrosion using 
Teflon sealant (grease) on the inside of the connector. A air-shrink” boot may be used to 
weatherize splices. Silicone paste should be used on the inside of the boot and electrical tape 
may be wrapped around the outside. Multi/ink Inc. makes a series of coaxial splice enclosures 
called a “Gelseal tm”’ designed for weatherproofing underground splices. Three different 
models are made for use with RG-6 cable (part number 3610-OS), RG-11 cable (part 
number 3611-OS). Although “Gelseal tm” splice enclosures cannot be used with ground 
blocks, they are appropriate for use with a barrel connector and two male F-connectors. The 
coax enters the building through a wall plug. The wall plug should also be weather proofed 
with RTV cement to prevent water from leaking inside. 

a. Verify that all outdoor exposed connectors are weather sealed in accordance with the local 
system standards.  
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3.0 LOS CPE Installation 
1.1 Installation Proofing Steps 

Prepare a Site survey Kit that includes the following basic items: 

13. Lightweight Survey Antenna w/Mount kit 

14. Telescopic Survey Mast or “Hotstick” 

15. Microred Transceiver Unit 

16. Signal Level Meter w/power supply onboard 

17. 2 25 meter RG-6 Coaxial Cable w/connectors 

18. Test CPE with RF Splitter (5-500Mhz) 

19. 1 10meter RG-6 Coaxial Cable w/connectors 

20. Expandable Ladder 

21. Basic Hand Tools 

22. Documentation 

23. Notebook PC and Null Modem Serial Cable 

24. 50Ohm Coax cable 3 meters w/ connectors 

Optional Accessories: 

9. GPS 

10. Compass 

11. Binoculars 

12. Location Map 

13. First Aid Kit 

14. Spectrum analyzer 

15. Coaxial Adapters 
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Site Survey Diagram 

 

 

1.2 Mounting Options 

Mounting Systems: The ingenuity of the wireless industry is proven by the fact that there 
are currently more than twelve different types of mounting systems in use to adapt an 
antenna to every conceivable type of structure. The most mounts are pipe mounts, eave 
mounts, chimney mounts, flat base mounts, and wall mounts can be used for smaller 
antennas of limited height on multistory buildings when other systems are inappropriate. 
Some of the more common application instructions for various types of mounting systems 
are covered below for general purposes. However, each mounting system has a specific set 
of assembly, application, and installation instruction provided by the manufacturer. Such 
detailed instructions should be scrupulously followed for proper performance of any specific 
product. 

Pipe Mounts. Pipe mounts are usually limited to small antennas in strong reception 
areas, which do not require significant height. They allow installers to attach a mast 
to a vent pipe. A pipe mount consists of a mast fitting with straps, which wrap 
around the pipe. They are used only with small antennas and short masts on heavy 
sewer pipes. Light aluminum pipes should be avoided with large antennas, which 
experience significant wind loading. 
 

Peak Mounts. Peak mounts use mast fittings, which have a base, which is shaped like an 
inverted “V.” They allow installers to anchor masts to peaked roofs. They may be used 
independently with short masts or with other kinds of mounting systems. Frequently they 
are used on peaked roofs to turn a tripod mount into a quadpod mount. 
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Universal Base Mount: Universal base mounts can be used to adapt a mast to a 
roof with any slope. Like peak mounts, they are sometimes used with quadpods. The 
mast fitting is equipped with a hinge which allowing a mast to be anchored to a roof 
at any angle. 

Guy Wire. Guy wires are attached to tall masts or towers to provide additional physical support. Current practice is to use a 

set of three or four guy wires for each ten-foot mast section starting at the top of the mast. At one end, the guy wires are attached 
to the mast using a guy ring and clamp. At the other end, the wires are anchored to solid building rafters or beams with appropriate 

screw eyes hooks or ram hooks. Guy wires should never be spliced. On masts under thirty-five feet, three guys are usually arranged at 120-
degree angles. On masts over thirty five-feet an arrangement of four guy wires at ninety-degree angles should be used. Guys will 

provide maximum support at a 45-degree angle with respect to either the mast or the ground. 

 
Quadpod Mounts: Quadpods have four legs. One of the Legs is actually the 
antenna mast. Quadpods are sometimes used for mounting a mast on either a flat 
roof or a sloped roof where a tripod will not work. Quadpods are made by using a 
tripod with a flat base, a peak mount, or a universal base mount. At least one of the 
legs should be anchored to a rafter. The mast must be vertical before all of the legs 
are anchored to the roof a tar pad and two lag screws are used on each of the 
diagonal legs. The center leg is anchored with either two or four lag screws 
depending upon the type of center mount used. Like tripods, quadpods are never 
used on tin roofs. 
 
Ground Mounts: In general, ground mounts can be classified into two groups - (1) 

Free standing ground mounts, and (2) those, which use a building for support. 
Freestanding ground mounts depend exclusively upon a ground anchor and guy 
wires for support. Building supported ground mounts relay upon the earth and an 
adjacent structure for support. 
In some areas of the country with single story buildings and flat terrain, ground mounts are used more often than tripods. They are 
used on single story structures because they are so easy to erect and ground. Ground mounts are also very solid and often do not 

require guys. The mast is anchored in the earth and supported by a building using a bracket. Twenty-foot ground mounts attached 
to a building do not require guy wires. However, mounts over twenty feet must be guyed. Eave mounts and wall mounts can also 

be combined with flat base systems to erect a ground mount when additional support is needed. 
 

1.3 Grounding Steps 

Grounding Masts & Supports: Article 810 of the NEC stipulates that masts and 
supporting mounts be grounded to provide discharge path to ground. When a near lightning 
strike occurs, powerful electromagnetic fields can induce surges in nearby conductors. Static 
charges can also build up during high winds. Hence, masts and supporting structures should 
be grounded using # 10 gauge wire. Connecting a second ground lead between the masts, 
mounting tripod, does this and coaxial ground block at the entry point. The ground lead 
may be attached to a mast using a ground strap. However, some installers use another 
ground block on the mast. The ground wire is then run from the antenna mount to the mast 
block and then down to the ground block at the near the point of entry. Article 810-17 (b) 
requires that any splices in a ground line must be permanent crimped splices made with a 
crimping tool. If the ground block at the point of entry is connected to a power riser, the 
mast and supporting mount may also be grounded to the same riser pipe (at the top). 
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1.4 Cable Installation Steps 

Down-Lead Routing: The coaxial down lead should be routed to the entry point 
by the most direct route possible. However, the route should always be either 
vertical or horizontal. Down-leads should never be routed across a wall at an angle. 
Sharp bends or kinks in a coaxial cable should be avoided since they can influence 
the cable’s frequency response. The effect of a sharp bend or kink can be so serious 
that the response may create a deep “notch” in the frequency response at some 
particular frequency. Damaged or broken coax can result in signal leakage. If 
external signals leak into the system, it can degrade reception. Also, if signals leak 
out of the system it could interfere with other radio services. Leakage is never one 
way. If signals are leaking into the down-lead system, they will also be leaking out. 
It is good practice to make a “drip loop” at the point where the coaxial cable enters the 
building. This loop prevents water from entering the building by dripping down the coaxial 
cable. It is also good practice to make service loops with the coax near the connectors at both 
the top and bottom of down lead. Service loops are also made on both connections to the 
ground block or at any point where an F connector is used. These loops provide extra cable 
for connecting test equipment during troubleshooting. They also provide some extra cable 
length in the event that bad connectors have to be replaced sometime in the future. Service 
loops are made twisting several turns of coax into a 4-inch loop and securing them with tie-
wraps. Service loops perform three functions. First, the additional cable length makes it 
easier to connect test equipment. Second, the additional length makes it easier to replace F-
connectors. Third, in some instances service loops may double as drip loops. 

1.5 Modem Module Installation Steps 

1. With the CPE modem disconnected from power, Connect the RG-6 Cable 
to the IF Connection on the back of the CPE. 

  

2. Connect the 10BaseT port of the CPE modem to your laptop using a 
Ethernet Crossed cable as partially pictured above 
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3. Connect the Supplied Power supply to the CPE modem and the compliant 
power source. 

4. Configure the CPE with the RF and IP parameters. Consult your System 
Administrator for the settings 

5. Configure the CPE PC with the proper network settings 

 

1.12 Weather Protection 

    Weatherproofing: External F Type connectors are weatherproofed against corrosion 
using Teflon sealant (grease) on the inside of the connector. A air-shrink” boot may be used 
to weatherize splices. Silicone paste should be used on the inside of the boot and electrical 
tape may be wrapped around the outside. Multi/ink Inc. makes a series of coaxial splice 
enclosures called a “Gelseal tm”’ designed for weatherproofing underground splices. Three 
different models are made for use with RG-6 cable (part number 3610-OS), RG-11 cable 
(part number 3611-OS). Although “Gelseal tm” splice enclosures cannot be used with ground 
blocks, they are appropriate for use with a barrel connector and two male F-connectors. The 
coax enters the building through a wall plug. The wall plug should also be weather proofed 
with RTV cement to prevent water from leaking inside. Verify that all outdoor exposed 
connectors are weathersealed in accordance with the local system standards. 

 

1.13 Documentation Steps 

Record all Relevant Installation and Customer Information per your System Administrator 
Guidelines.  
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4.0 Network Management 
System (snmp) 

Configuring the Microred System using SNMP 
and an NMS 

 

This Chapter describes how to configure the system using the industry standard SNMP 
(Simple Network Management Protocol) and an NMS MIB Browser (Network 
Management System Management Information Base Browser).  In this chapter we will 
be using the Adventnet Web-based NMS as our user interface application.  However, 
any NMS, such as HP OpenView, can be used to configure and monitor the system.  
You will need to have the Pointred Technologies’ enterprise MIB file and the NMS 
loaded on a computer.  The Pointred Technologies MIB file is named prt.mib .  The 
Adventnet Web NMS is available for windows on a demo basis from 
http://www.adventnet.com . 
 
To configure the system, you will also need to know the system’s LAN IP address.  
This can be set or read from the RS232 port.  See above.  You will need to know the 
SNMP read-write community for the system.  This defaults to public . 
 
Note also that the system implements both the Pointred Technologies enterprise MIB 
and the standard RFC-1213 MIB.  Only the Pointred Technologies enterprise MIB is 
used to configure the system, as described below.  The RFC-1213 MIB is used mainly 
for monitoring standard aspects of the system. 
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Start the NMS from the start bar.  Then double click the “Start Web NMS Server” 
icon: 
 

 
 
This will start the back end of the NMS.  Now click on the “Administrator Tools” icon: 
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Now click on the “MIB Browser” icon: 
 

 
 
This will bring up the MIB Browser:  Go to File > Load MIB 
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Enter the full file path to the prt.mib file: 
 

 
 
The Pointred Technologies MIB tree can be expanded in the right window.  Now enter 
the systems LAN IP address in the Host field. 
 

 
 
The leaf icons at the right indicate the various values that can be read using the GET 
command on the menu bar.  Leaf icons with X’s on them indicate read-only values.  
The other icons can also be written via the SET command on the menu bar in 
conjunction with the Set Value field in the upper right.  Whenever a leaf is selected, 
information about the leaf appears in the lower right section.   Values can be read or 
written in any order.  However, changing the LAN IP address or the LAN IP MASK 
may make the system unreachable by the NMS.  You will have to use the RS232 port to 
access the system in that case. 
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The table below gives important values that you may want to examine or set in a Base 
station: 
 

Leaf Name Description Writa
ble 

Values 

prtBaseProductType product type No CPE (1), BASE (2), etc 
prtBaseVersion product version No A character string 
prtBasePartNo Part Number No A character string 
prtBaseCreated software 

creation date 
No A character string 

prtBaseMacAddress MAC address of 
the Base’s 
10BaseT 
Ethernet 
controller 

Yes Any unique 6 byte value (entered 
as in this example: 
00:11:22:33:44:55) 

prtBaseNetwork network 
structure of the 
Base 

Yes PointToMultipoint (1) or 
PointToPoint (2) 

prtBaseConnection type of 
connection used 
to communicate 
with the CPE(s) 

Yes CableApplication (1), 
TransceiverApplication  
(2) 

prtBaseLanIpAddress LAN IP address Yes Dot notation as in: 0.1.2.3 

prtBaseLanIpMask LAN IP mask Yes Dot notation as in: 
255.255.255.0 (only lowest 
order byte is settable). 

prtBaseWanIpAddress WAN IP address Yes Dot notation as in: 0.1.2.3 

prtBaseWanIpMask WAN IP mask Yes Dot notation as in: 
255.255.255.0 

prtBaseGatewayIpAddress Gateway IP 
Address 

Yes Dot notation as in: 0.1.2.3 

prtBaseGatewayIpMask Gateway IP 
mask 

Yes Dot notation as in: 
255.255.255.0 

prtBaseTransceiverOn turns the 
transceiver on or 
off 

Yes ON (1) or OFF (2) 

prtBaseTransceiverMode transceiver 
Mode 

Yes 1 through 5 

prtBaseTransceiverFrequency transceiver 
frequency in 
Mhz 

Yes 2405 to 2480 in increments of 
5. 

prtBaseTransceiverPower transceiver 
transmit power 

Yes off (represented by a value of 1) 
to maximum (represented by a 
value of 255) 
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prtBaseAutoAddressing controls whether 
CPE(s) are 
added with 
Automatic IP 
Numbering 

Yes ON (1) or OFF (2) 

prtBaseCPEAuthentication controls whether 
CPE Authen-
tication is 
enabled 

Yes ON (1) or OFF (2) 

 
The Base system also controls the CPE with which it communicates.  This control 
includes adding and deleting CPE’s from its view and changing various CPE values.  
This is accomplished by using the SNMP table feature of the MIB Browser.  First select 
prtCpeDevices from the right hand tree view: 
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Now go to View > Snmp Table > Start.  You will see a table of all available CPE’s and 
some empty entries:    
 

 
 
Make sure auto addressing is on (see prtBaseAutoAddressing  in the table above).  
You add a CPE with default values, using the createRequest setting in the last field 
of the table: 
 

 



 

 3939 

Refresh the table using either the Start or the Refresh button.  The field will now show 
valid if the CPE entry was committed successfully in the Base.  To delete a CPE, set the 
same field to invalid: 
 

 
  
Any changes to a field in this table will be committed in the Base only after another 
createRequest is issued on the respective line. 
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Here are the available fields in the CPE table: 
 

Leaf Name Description Writa
ble 

Values 

prtCpeTransceiverFrq transceiver 
frequency in 
Mhz 

Yes 2405 to 2480 in increments of 
5. 

prtCpeTransceiverPwr transceiver 
transmit power 

Yes off (represented by a value of 1) 
to maximum (represented by a 
value of 255) 

prtCpemacaddr MAC address of 
the CPE’s 
transceiver 

Yes Any unique 6 byte value (entered 
as in this example: 
00:11:22:33:44:55) 

prtCpelanipaddr CPE’s LAN IP 
address 

Yes Dot notation as in: 0.1.2.3 

prtCpelanipmsk CPE’s LAN IP 
mask 

Yes Dot notation as in: 
255.255.255.0 (only lowest 
order byte is settable). 

prtCpepwanipaddr CPE’s WAN IP 
address 

Yes Dot notation as in: 0.1.2.3 

prtCpepwanipmsk CPE’s WAN IP 
mask 

Yes Dot notation as in: 
255.255.255.0 

prtCpecurrentstatus CPE’s status 
string 

Yes “OK” if Base sees this CPE entry 
as good 

prtCpeentryStatus Setting this 
values performs 
a commit for the 
whole CPE row 

Yes valid (1), createRequest 
(2), createPending (3), 
invalid (4) 

    
 


